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Simplified workflow for project setup and results review with a unified
user interface

In R2015a, the Project and Results Manager perspectives are now unified. You can run
verification and review results without switching between two perspectives.

The major changes are:

• You can start a new verification during your results review. Previously, you started a
new verification only from the Project Manager perspective.

• After a verification, the result opens automatically. If you are looking at a previous
result when a verification is over, you can load the new result or retain the previous
one on the Results Summary pane. If you retain the previous results, you can later
open the new results from the Project Browser. The new results are highlighted.

• You can have any of the panes open in the unified interface.

Previously, you could open the following panes only in one of the two perspectives.

Project Manager Results Manager

• Project Browser: Set up project.
• Configuration: Specify analysis

options for your project.
• Output Summary: Monitor progress

of verification.
• Full Log: Find all information about a

verification.

• Results Summary: View Polyspace®

results.
• Source: View read-only form of

source code color coded with Polyspace
results.

• Check Details: View details of a
particular result.

• Check Review: Comment on a
particular result.

• Variable Access: View global
variables and read/write operations on
them.

• Call Hierarchy: View callers and
callees of a function.

• Results Properties: Same as Full
Log, but associated with results
instead of a project. This pane has
been removed.
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Project Manager Results Manager

• Settings: Same information as
Configuration, but associated with
results instead of a project. This pane
has been removed.

• Orange Sources: View sources of
orange checks.

• Sensitivity Context: For a check
that has a different color for different
function calls, view the check color for
each function call.

Code complexity metrics available in user interface

In R2015a, you can view code complexity metrics in the Polyspace user interface.
Previously, this information was available only in the Polyspace Metrics web interface.

In the user interface, you can:

• Specify a limit for the value of a metric. If the metric value for your source code
exceeds this limit, the metric appears red on the Results Summary pane.

• Justify the value of a metric. If a metric value exceeds specified limits and appears
red, you can add a comment with the rationale.

• Generate a report containing the metric values and associated comments and
justifications.

Combining these actions, you can enforce coding standards across your organization.

Reducing the complexity of your code improves code readability, reduces the possibility of
coding errors, and allows more precise Polyspace verification.

For more information, see “Code Metrics”.

Review of global variable usage

In R2015a, you can comment and justify global variable usage on the Results Summary
pane. Previously, you viewed global variable usage on the Variable Access pane, but
could not comment on them.
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On the Results Summary pane, global variables are classified into one of the following
categories.

Category Color Meaning

Potentially
unprotected

Orange Global variables
shared between
multiple tasks
but possibly not
protected from
concurrent access by
the tasks

Shared

Protected Green Global variables
shared between
multiple tasks and
protected from
concurrent access by
the tasks

Unused Gray Global variables
used in a single task

Not shared

Used Black Global variables
declared but not
used

For code that you do not intend for multitasking, all variables are nonshared and can be
either used or unused. For code that you intend for multitasking, you can specify tasks
and protections through the analysis options for multitasking. For more information, see
“Entry points”, “Critical section details” and “Temporally exclusive tasks”.

You can still view the global variables on the Variable Access pane.

• To comment and justify potentially unprotected and unused global variables, use the
Results Summary pane.

• To find all read and write operations on a global variable, use the Variable Access
pane.

For more information, see “Global Variables”.
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Review of latest results compared to last run

In R2015a, you can review only new results compared to the previous run.

If you rerun your verification, the new results are displayed with an asterisk (*) against
them on the Results Summary pane. To filter only these new checks, select the New
results box.

If you make changes in your source code, you can use this feature to see only the checks
introduced due to those changes. You can avoid reviewing checks in the source code that
you did not change.

Improvements in search capability in the user interface

In R2015a, the Search pane allows you to search for a string in various panes of the user
interface.

To search for a string in the new user interface:

1 If the Search pane is not visible, open it. Select Window > Show/Hide View >
Search.

2 Enter your string in the search box.
3 From the drop-down list beside the box, select names of panes you want to search.

The Search pane consolidates all the search options previously available:

• In the Project Manager perspective, the global search box allowed you to search on the
Configuration pane.

• In the Results Manager perspective, the global search box allowed you to search on
the Source, Results Summary, Call Hierarchy, and Variable Access panes.

• Search boxes on the Output Summary and Full Log panes allowed you to search on
those panes.

Simplified results infrastructure

Polyspace results folders are reorganized and simplified. Files have been removed,
combined, renamed, or moved. The changes do not affect the results that you see in the
Polyspace environment.

Some important changes and file locations:
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• The main results file is now encrypted and renamed ps_results.rte. You can view
results only in the Polyspace environment.

• The log file, Polyspace_R2015a_project_date-time.log has not changed.

For more information, see Results Folder Contents.
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Code Editor for Editing Source Files in Polyspace User Interface

In R2014b, by default, you can edit your source files inside the Polyspace user interface.

• In the Project Manager perspective, on the Project Browser tree, double-click your
source file.

• In the Results Manager perspective, right-click the Source pane and select Open
Source File.

Your source files appear on a Code Editor tab. On this tab, you can edit and save your
source files.

To use an external text editor, change your preferences.

1 Select Tools > Preferences.
2 Specify an external editor on the Editors tab.

For more information, see Specify External Text Editor.

Contextual help for verification options and checks

In R2014b, contextual help is available for verification options in the Polyspace interface
and its plug-ins. To view the contextual help:

1 Hover your cursor over a verification option in the Configuration window.
2 Inside the tooltip, select the “More Help” link.

The documentation for that analysis option appears in a new window.

Contextual help is available in the Polyspace interface for checks. To view the contextual
help:

1 In the Results Manager perspective, select a runtime error.
2

Inside the Check Details window, select .

The documentation for that check appears in a dockable window.

For more information about getting help in the Polyspace interfaces, see Learning More.

http://www.mathworks.com/help/releases/R2014b/polyspace_ada/ada_ug/specify-text-editor.html
http://www.mathworks.com/help/releases/R2014b/polyspace_ada/ada_gsg/learning-more.html
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Default verification level changed

In R2014b, unless you specify a verification level explicitly, Polyspace verification
performs two passes on your source code instead of four. For instance:

• In the user interface, on the Output Summary tab, you can see that the verification
continues to Level2. For more passes, on the Configuration pane, under the
Precision node, select a Verification level.

• At the command line, the verification implicitly uses -to pass2. For more passes,
use the -to option explicitly with a higher pass value.

The default verification is completed in much less time.

For more information, see Verification level.

Compatibility Considerations

If you do not specify a verification level explicitly in your polypsace-ada command,
your verification runs to Software Safety Analysis Level 2. In most cases, this
verification level produces only slightly more orange checks than Software Safety
Analysis Level 4. However, if you see a significant change in your results, to
reproduce your earlier results:

• In the user interface, select Software Safety Analysis Level 4 for
Verification level.

• At the command line, use the option -to pass4 with the polypsace-ada command.

Improved global menu in user interface

The global menu in the Polyspace user interface has been updated. The following table
lists the current location for the existing global menu options.

Goal Prior to R2014b R2014b

Open the Polyspace Metrics
interface in your web
browser.

File > Open Metrics Web
Interface

Metrics > Open Metrics

Upload results from the
Polyspace user interface to
Polyspace Metrics.

File > Upload in
Polyspace Metrics
repository

Metrics > Upload to
Metrics

http://www.mathworks.com/help/releases/R2014b/polyspace_ada/ada_ref/verification-level.html
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Goal Prior to R2014b R2014b

Update results stored in
Polyspace Metrics with
your review comments and
justifications.

File > Save in Polyspace
Metrics repository

Metrics > Save comments
to Metrics

Generate a report from
results after verification.

Run > Run Report > Run
Report

Reporting > Run Report

Open generated report. Run > Run Report >
Open Report

Reporting > Open Report

Import review comments
from previous verification.

Review > Import Tools > Import Comments

Specify settings that apply
to all Polyspace projects.

Options > Preferences Tools > Preferences

Specify settings for remote
verification.

Options > Metrics and
Remote Server Settings

Metrics > Metrics and
Remote Server Settings

Improved Project Manager perspective

The following changes have been made in the Project Manager perspective:

• The Progress Monitor tab does not exist anymore. Instead, after you start a
verification, you can view its progress on the Output Summary tab.

• In the Project Browser, projects appear sorted in alphabetical order instead of order
of creation.

Improved Results Manager perspective

The following changes have been made in the Results Manager perspective:

• To prioritize your orange check review, use the Show menu on the Results
Summary pane. This menu replaces the previously available methodologies for the
same purpose.

• To display red, gray and orange checks likely to be run-time errors, from the Show
menu, select Critical checks. This option replaces the First checks to review
methodology.
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• To display all checks, from the Show menu, select All checks. This option
replaces the All checks methodology.

• The methodologies Methodology for Ada > Light and Methodology for Ada >
Moderate no longer exist.

• To create your own subset of orange checks to review, select Tools > Preferences.
On the Review Scope tab, specify the number or percentage of orange checks of
each type to review. The options on this tab replace the options on the Review
Configuration tab.

• To group your checks, use the Group by menu on the Results Summary pane.

• To leave your checks ungrouped, instead of List of Checks, select Group by >
None.

• To group checks by check color and type, instead of Checks by Family, select
Group by > Family.

• To group checks by file and function, instead of Checks by File/Function, select
Group by > File.

• To view the percentage of checks that you have justified, instead of the Review
Statistics pane, use the Justified column on the Results Summary pane. On this
pane:

• To view the percentage of checks that you justified broken down by color/type,
select Group by > Family.

• To view the percentage of checks that you justified broken down by file/function,
select Group by > File.

Remote launcher and queue manager renamed

Polyspace has renamed the remote launcher and the queue manager that shows jobs sent
for remote verification. The server computer that manages all other server computers is
still called the Queue Manager server.

Previous name Use instead More information

polyspace-rl-manager polyspace-server-

settings

Only the binary name has changed.
The interface title, Metrics and
Remote Server Settings, is
unchanged.
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Previous name Use instead More information

polyspace-spooler polyspace-job-monitor

Queue Manager or
Spooler

Job Monitor
The binary and the interface titles
have changed. Interface labels have
changed in the Polyspace interface
and all its plug-ins.

Compatibility Considerations

You receive a warning if you use the old binaries or functions.
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Remote launcher and queue manager renamed

Polyspace has renamed the remote launcher and the queue manager that shows jobs sent
for remote verification. The server computer that manages all other server computers is
still the Queue Manager server.

Previous name Use instead More information

polyspace-rl-

manager.exe

polyspace-server-

settings.exe

Only the binary name has
changed. The interface
title, Metrics and Remote
Server Settings, is
unchanged.

polyspace-spooler.exe polyspace-job-

monitor.exe

Queue Manager or
Spooler

Job Monitor

The binary and the interface
titles have changed.
Interface labels have
changed in the Polyspace
interface and all its plug-ins.

Compatibility Considerations

You receive a warning if you use the old binaries or functions.

Local unit-by-unit verification

In R2014b, you can verify your source code file by file on your local installation
of Polyspace. Each file is verified independently of the other files in your module.
Previously, you could perform such unit-by-unit verification only on a remote server.
However, you still require a Polyspace Server™ license.

For more information, see Running Verification Unit-by-Unit.

http://www.mathworks.com/help/releases/R2014b/polyspace_ada/ada_ug/running-verifications-on-polyspace-server.html#br_rk17-1
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Default Text Editor

In R2014a, Polyspace uses a default text editor for opening source files. The editor is:

• WordPad in Windows®

• vi in Linux®

You can change the text editor from the Editors tab under Options > Preferences. For
more information, see Specify Text Editor.

Support for Windows 8 and Windows Server 2012

Polyspace supports installation and analysis on Windows 8 and Windows Server® 2012 in
compatibility mode.

Before installing the product in these operating systems:

• Right-click setup.exe and select Properties.
• Select the Compatibility tab.
• Check the Run this program in compatibility mode for box and from the drop-

down list, select Windows 7.

For further installation instructions, see Install the Polyspace Software.

http://www.mathworks.com/help/releases/R2014a/polyspace_ada/ada_ug/specify-text-editor.html
http://www.mathworks.com/help/releases/R2014a/polyspace_ada/polyspace_install/installing-the-polyspace-software.html
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Support for Windows 8 and Windows Server 2012

Polyspace supports installation and analysis on Windows 8 and Windows Server 2012 in
compatibility mode.

Before installing the product in these operating systems:

• Right-click setup.exe and select Properties.
• Select the Compatibility tab.
• Check the Run this program in compatibility mode for box and from the drop-

down list, select Windows 7.

For further installation instructions, see Install the Polyspace Software.

http://www.mathworks.com/help/releases/R2014a/polyspace_ada/polyspace_install/installing-the-polyspace-software.html
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Display call context analysis within a procedure

The software displays call context information for checks contained in a given procedure.
For example, if one call of the procedure results in a red check, and another call results in
a green check, the call information and color for both calls is kept in the procedure check.

User interface support for Japanese language

The software supports a Japanese user interface.

Project level statistics such as code covered by verification and
itemization of checks

In R2013b, in the Project Manager interface, percentage code covered by verification and
check distribution are shown in a graphic format in the Verification Statistics view.

• Code covered by verification — Ratio of unproven code lines to total code lines,
expressed as a percentage. Shown in a column graph format.

• Check distribution — Number of checks of each color. Shown in a pie chart format.

New “results statistics” in the results review user interface

In R2013b, in the Results Manager interface, percentage code covered by verification and
check distribution are shown in a graphic format in the Results Statistics view.

• Code covered by verification — Ratio of unproven code lines to total code lines,
expressed as a percentage. Shown in a column graph format.

• Check distribution — Number of checks of each color. Shown in a pie chart format.

Improved filtering, grouping and ordering of results in “results summary”
view

In R2013b, the Results Summary and the Results Explorer view have been merged
into a more organized Results Summary view.
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• In the Results Summary view, the error names are shown in an expanded format.
Previously, a division-by-zero error appeared as ZDV.num in the Results Explorer
view. Now it appears as Division by Zero in the revised Results Summary view.

• You can now group checks by File/Function,Check and Package. In addition to
check color, grouping by Check divides checks into categories related to the origin of
the check, such as Control flow, Data flow, and Numerical.

• You can now filter checks by File, Package and Function, in addition to existing
filters. You can filter checks using the columns in the Results Summary view. If you
have applied a filter, the column heading changes to indicate that all results are not
displayed. You can also define custom filters.

• You can use one of four predefined methodologies to restrict number and type of
checks displayed (replacing review levels 0,1,2, and 3). The methodologies are :

• First checks to review
• Methodology for Ada > Light
• Methodology for Ada > Moderate
• All checks

You can also use custom methodologies to restrict checks displayed.
• You can navigate the Results Summary view using the keyboard or GUI buttons.

Both means of navigation respect the grouping, filters, and methodology used to
display results.

Project configuration file extension renamed

The software saves project configuration files with the .psprj extension. Previously, the
file extension was .cfg.

No generation of Excel output

In R2013b, the following features are not supported:

• Export of review comments to an Excel® spreadsheet.
• Generation of Excel reports for verification results.
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Starting an R2013a remote verification

If the R2013a and R2013b versions of Polyspace are installed on a client computer,
submitting a R2013a remote verification from the client generates an error. For example:
/etc/Polyspace/polyspace.conf, line 7: Error: Duplicate entry for Polyspace for Ada 6.5 (R2013a).

As a temporary workaround, remove the R2013b version from the client configuration:

1 Select Options > Metrics and Remote Server Settings.
2 In the Polyspace Server Settings section, remove the product entry for R2013b.
3 Click Apply.

Changes to verification results

None

Changes to analysis options

• “New options” on page 4-4
• “Changes to existing options” on page 4-4

New options

The option -context-sensitivity is provided. See “Display call context analysis
within a procedure” on page 4-2 and “Call context analysis during verification of
procedure” on page 4-5.

Changes to existing options

The -max-processes option is available only from the command line.

Options removed

The option -code-metrics has been removed. By default, the software computes code
complexity metrics.
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Call context analysis during verification of procedure

The software considers context in the analysis of a procedure. For example, if one call of
the procedure results in a red check, and another call results in a green check, the call
information and color for both calls is kept in the procedure check.

Polyspace Remote Launcher Manager dialog box renamed

To configure your Polyspace server, use the Metrics and Remote Server Settings dialog
box. Previously, this dialog box was called the Polyspace Remote Launcher Manager.

The name of the line command, polyspace-rl-manager, is unchanged.
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Modified Polyspace installer

In R2013a:

• The Polyspace installer does not create the Polyspace_Common folder.
• The Polyspace product does not depend on environment variables, that is, the

installer does not create POLYSPACE_* variables.
• The Remote Launcher Manager does not open automatically during the installation

process. In addition, if the service or daemon was running before the installation
of the new product, the service or daemon is not automatically restarted. You must
manually open the Remote Launcher Manager, configure your Polyspace Server, and
then start the service or daemon.

• You must manually install Polyspace plug-in (or add-in) files. The Polyspace installer
does not automatically activate these files. For example, before you run a verification
from the Eclipse™ IDE, you must manually install the Polyspace plug-in file.

The following table provides information about new locations for files and folders.

Binary files Location in previous release Location in R2013a

Polyspace
verification
environment

Polyspace_Install\PVE

\Polyspace.exe

Polyspace_Install/PVE/bin/

polyspace

Polyspace_Install\polyspace

\bin\polyspace[.exe]

Polyspace for
Ada

Polyspace_Install\Verifier\wbin

Polyspace_Install/Verifier/bin

Polyspace_Install\polyspace

\bin

Spooler Polyspace_Common\RemoteLauncher

\wbin\PSQueueSpooler.exe

Polyspace_Common/RemoteLauncher/

bin/polyspace-spooler

Polyspace_Install\polyspace

\bin\polyspace-spooler[.exe]

Polyspace
plug-in for
Eclipse

Polyspace_Common\PolyspaceForEclipsePolyspace_Install\polyspace

\plugin\eclipse
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Binary files Location in previous release Location in R2013a

Polyspace
plug-in
for IBM®

Rational®

Rhapsody®

Polyspace_Common\PolyspaceUMLLink Polyspace_Install\polyspace

\plugin\rhapsody

Remote
Launcher

Polyspace_Common\RemoteLauncher Polyspace_Install\polyspace

\bin

Report
Generator

Polyspace_Common\ReportGenerator Polyspace_Install\polyspace

\bin\polyspace-report-

generator

For more information, see:

• Polyspace Software Administration
• Install Polyspace Plug-In for Eclipse IDE

Verification uses native binary file

In R2013a, the Polyspace verification is run using the native binary file for your
computer architecture. Previously, you specified a 32-bit or 64-bit verification through
the option -machine-architecture option_value. Now, if you specify -machine-
architecture, the software ignores the option and generates the following warning:

Option “-machine-architecture option_value” is obsolete.

Verification run using native binary file for your computer architecture.

Previously, the default option value (auto) specified 32-bit verification. Now, on a Linux
system, the Polyspace verification is 64-bit. You may observe an increase in verification
time compared to previous releases. The increase depends on the application being
verified and the architecture of your machine.

Note: For Linux systems, only the Polyspace 64-bit Client and Server products are
supported.

http://www.mathworks.com/help/releases/R2013a/polyspace_ada/index.html
http://www.mathworks.com/help/releases/R2013a/polyspace_ada/ada_ug/install-polyspace-plug-in-for-eclipse-ide.html
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Exact representation of floating point numbers

Polyspace uses the exact value of a representable floating point number during code
verification. Consider the floating point value of 1.0. Previously, Polyspace represented
this value as a range 0.9999 – 1.0001. Now, Polyspace uses the exact value, that is 1.0.

Changes to verification results

None

Changes to analysis options

• “New options” on page 5-4
• “Changes to existing options” on page 5-4

New options

None

Changes to existing options

None

Options removed

The -machine-architecture option has been removed. See “Verification uses native
binary file” on page 5-3.
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Improved Polyspace Metrics security with HTTPS

You can now configure the Polyspace Metrics Web server with a secure HTTPS protocol.
This configuration enables encrypted communication between the Polyspace server and
the Polyspace Metrics Web interface. See Configure Polyspace Metrics Web Interface.

http://www.mathworks.com/help/releases/R2013a/polyspace_c/polyspace_install/configuring-polyspace-metrics-web-interface.html
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Review of verification results improvement

Check filters in results summary view

The Results Summary toolbar provides check filters, which previously were available
only in the Results Explorer view.

You can apply the check filters from either view. For example, if you filter checks by color
and category in the Results Summary view, the software also filters out these checks
from the Results Explorer view. For more information, see Filtering Checks.

Justify and comment a group of checks

You can now select a group of checks in either the Results Explorer or Result
Summary view, and then justify and add review information to those checks. For more
information, see Reviewing and Commenting Checks.

Variable values in tooltips

The display of variable values in Source view tooltips is improved, providing information
that narrows the range of the variable. For example, the tooltip might indicate whether
the variable values are multiples of a number. The following table has examples of how
tooltips display variable range values.

Previously R2012b

0 or 2 or 4 or [6 .. 2147483642

(0x7FFFFFFA)]

even values in [0 .. 2147483642

(0x7FFFFFFA)]

http://www.mathworks.com/help/releases/R2012b/polyspace_ada/ada_ug/reviewing-results-in-expert-mode.html#brz384r-25
http://www.mathworks.com/help/releases/R2012b/polyspace_ada/ada_ug/tracking-review-progress.html#bsg3vp7-3
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Previously R2012b

[-56 ..110] or [112 .. 166] even values in [-56 .. 166]

[-1265 .. -46] or -23 or 0 multiples of 23 in [-1265 .. 0]

[0 .. 22] or 44 0 or 22 or 44

You might also see the following type of tooltip for variables:
1008 or 4800 or 14400 or 23040 (values are multiples of 48)

This enhancement might affect the contents of the text file
Your_Project_Variable_View.txt file, which your verification generates in the …
\results\Polyspace-Doc folder. Instead of only an interval list for a variable, you
might see, for example, the following conventions in the file:

• multiples of (a constant) in (the interval list)
• even values in (the interval list)
• odd values in (the interval list)

Reorganized Configuration pane

The Project Manager perspective of the Polyspace verification environment provides
a reorganized Configuration pane that allows improved management of verification
options.

The configuration process for code verification consists of different parts, for example,
specifying your target environment and compiler behavior. The Configuration pane
contains a tree with nodes that represent different parts of the configuration process.
For example, to choose your target environment and compiler, select the Target &
Compiler node and then specify your options.
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You can specify the following option from the command line or through the
Configuration > Machine Configuration > Non-official options field.

From command line Removed from Configuration pane

-keep-all-files Keep all preliminary results files

Polyspace plug-in for Eclipse with GNATbench

The Polyspace plug-in for the Eclipse IDE now supports Ada projects generated by
GNATbench.

You can run verifications for Ada projects from the Eclipse IDE. However, Polyspace
settings are not extracted from the Eclipse project.

Report content filtering

Previously, you used the MATLAB® Report Generator™ software to apply filters to
report templates through only the Run-time Check Details Ordered by Color/
File component. The software provides a new component, Report Customization
(Filtering), which allows you to apply filters from any point of the report hierarchy.

For more information, see Customizing Verification Reports.

Parent folder for verification results

You can now specify a parent folder for your verification results through the Project
and result folder tab of the Polyspace Preferences dialog box. If you do not specify a
parent folder, the software uses the active module folder as the parent folder. For more
information, see Specify Parent Folder for Results.

Support for relative paths

The Polyspace Project Manager now supports relative paths outside the project
hierarchy. For example, paths for source files in a folder above the project location.
Previously, relative paths were supported only for subfolders of the project.

Absolute paths are still supported.

http://www.mathworks.com/help/releases/R2012b/polyspace_ada/ada_ug/generating-reports-of-verification-results.html#bs6zag5
http://www.mathworks.com/help/releases/R2012b/polyspace_ada/ada_ug/creating-a-project.html#br02rd8-1
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Intermediate verification level support

From the Polyspace verification environment, you can no longer specify the value CDFA
or “Control and Data Flow Analysis” for the option -to. If this value is specified
in a project configuration file (.cfg), the software replaces the value with compile or
“Source Compliance Checking”. However, from the command line, you can still
specify CDFA or “Control and Data Flow Analysis” for -to.

Automatic import of comments and justifications

You can specify the batch option -import-comments
polyspace_results_folder_path to automatically import comments and
justifications from a previous verification. For more information, see Batch Options.

Storage of temporary files

If you specify the new option -tmp-dir-in-results-dir, Polyspace does not use the
standard /tmp or C:\Temp folder to store temporary files. Instead, Polyspace uses a
subfolder of the results folder. If the results folder is mounted on a network drive, this
action might affect processing speed. Use this option only when the temporary folder
partition is not large enough and troubleshooting is required.

For more information, see Batch Options.

Removal of Polyspace in One Click

The Polyspace in One Click feature will be removed in a future release.

Changes to verification results

None

Changes to analysis options

New options

None

http://www.mathworks.com/help/releases/R2012b/polyspace_ada/ada_ref/batch-options.html
http://www.mathworks.com/help/releases/R2012b/polyspace_ada/ada_ref/batch-options.html
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Changes to existing options

Analysis options have been reorganized in the Project Manager. See “Reorganized
Configuration pane” on page 6-3.

Project Manager perspectiveOption

Previous label R2012b label Location on R2012b
Configuration pane

See also ...

-add-to-results-

repository

Add
automatically
to results
repository

Add to results
repository

Machine
Configuration

 

-array-

expansion-size

Max size of
global array
variables

Unchanged Precision  

-base-type-

directly-visible

Remove
comparison
operators
ambiguities

Unchanged Target & Compiler  

-code-metrics Calculate code
metrics

Calculate
code
complexity
metrics

Code Metrics  

-continue-with-

all-niv

Continue after
non initialized
variables

Unchanged Verification
Assumptions

 

-continue-with-

in-out-niv

Continue
with non-
initialized in/out
parameters

Unchanged Verification
Assumptions

 

-critical-

section-begin

and -critical-

section-end

Critical section
details

Unchanged Verification Mode  

-D Defined
Preprocessor
Macros

Preprocessor
definitions

Targets & Compler
> Macros
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Project Manager perspectiveOption

Previous label R2012b label Location on R2012b
Configuration pane

See also ...

-data-range-

specifications

Variable/
function range
setup

Unchanged Verification Mode >
Inputs & Stubbing

 

-entry-points Entry points or
interruption

Entry points Verification Mode  

-export-are-not-

volatile

Treat export as
non volatile

Unchanged Verification
Assumptions

 

-extensions-for-

spec-files

Files extensions Unchanged Target & Compiler  

-extra-flags   Non-official
options

Machine
Configuration

 

-ignore-float-

rounding

Ignore float
rounding

Unchanged Verification
Assumptions

 

-import-are-not-

volatile

Treat import as
non volatile

Unchanged Verification
Assumptions

 

-init-stubbing-

vars-random or -
init-stubbing-

vars-zero-or-

random

Initialize of
uninitialized
global variables

Initialization
of
uninitialized
global
variables

Verification Mode >
Inputs & Stubbing

 

-keep-all-files Keep all
preliminary
results files

Command line
only

   

-known-NTC Functions
known to cause
NTC

Procedures
known to
cause NTC

Verification
Assumptions

 

-machine-

architecture

Run verification
in 32 or 64-bit
mode

Unchanged Machine
Configuration

 

-main-generator Generate a main Verify module Verification Mode  
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Project Manager perspectiveOption

Previous label R2012b label Location on R2012b
Configuration pane

See also ...

-max-processes Number of
processes for
multiple core
system

Unchanged Machine
Configuration

 

-modules-

precision

Specific
precision

Unchanged Precision  

-no-automatic-

stubbing

No automatic
stubbing

Unchanged Verification Mode >
Inputs & Stubbing

 

-O Precision Level Precision
level

Precision  

-OS-target Target
operating
system

Unchanged Target & Compiler  

-path-

sensitivity-

delta

Improve
Precision of
interprocedural
analysis

Unchanged Precision  

-permissive Permissive Command line
only

   

-post-analysis-

command

Command to
apply after
the end of the
verification

Unchanged Post Verification  

-pre-analysis-

command

Command/script
to apply before
start of the code
verification

Unchanged Environment
Settings

 

-report-output-

format

Report output
format

Output
format

Reporting  

-report-template Report template Report
template
name

Reporting  
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Project Manager perspectiveOption

Previous label R2012b label Location on R2012b
Configuration pane

See also ...

-server Send to
Polyspace
Server

Unchanged Machine
Configuration

 

-storage-unit Value of the
constant
Storage_Unit

Unchanged Target & Compiler  

-strict Strict Command line
only

   

-target Target
processor type

Unchanged Target & Compiler  

-temporal-

exclusions-file

Temporal
exclusion point

Temporally
exclusive
tasks

Verification Mode  

-timeout Verification
time limit

Unchanged Precision  

-to To end of Verification
level

Precision “Intermediate
verification
level support”
on page
6-5

-U Undefined
Preprocessor
Macros

Undefine
preprocessor
definitions

Targets & Compler
> Macros

 

-unit-by-unit Run a
verification unit
by unit

Run unit
by unit
verification

Verification Mode  

-unit-by-unit-

common-source

Unit by unit
common source
files

Unchanged Verification Mode  

-variables-

expansion-depth

Expansion limit
for a structure

Unchanged Precision  
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Project Manager perspectiveOption

Previous label R2012b label Location on R2012b
Configuration pane

See also ...

-variables-to-

expand

Variables to
expand

Unchanged Precision  

Options removed

None
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Password-protected access to projects in Polyspace Metrics

You can now restrict access to a project by specifying a password:

• When you run a verification with Polyspace Metrics enabled or upload results to the
Polyspace Metrics repository.

• After the creation of a project.

For more information, see Protect Access to Project Metrics.

http://www.mathworks.com/help/releases/R2012b/polyspace_ada/ada_ug/accessing-polyspace-metrics.html#btmdtck
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Compilation Environment Templates

Polyspace software now provides predefined compilation environment templates to help
you configure verification projects.

These templates automatically set analysis options for the selected compiler, and help
you locate the required include folders.

When creating a new project, you can select a template for your compiler.

For more information, see Creating a Project.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/br0l5ad-5.html
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Predefined Templates

Predefined templates are available for:

• Aonix – Ada 95 Application Targeting the Aonix Compiler
• Baseline – Generic Ada95 application
• Gnat – Ada 95 Application Targeting the Gnat Compiler
• Greenhills – Ada 95 Application Targeting the Greenhills Compiler
• Rational – Ada 95 Application Targeting the Rational Compiler

Custom Templates

You can also create custom templates from existing Project configurations, and use them
to configure future projects.

For more information, see Creating Custom Project Templates.

Suppression of NTC, NTL and UNR Checks Caused by Red Checks

Previously, the software would generate red NTC and NTL checks that were a
consequence of other red checks. Now, the software does not generate these red checks.
However, the software still gives the information that these red checks provided. The
software highlights the corresponding call or loop identifier by applying a dashed
underline to the identifier.

If the cause of the problem is known, the software provides this information in a tooltip
for the underlined call or loop identifier. In addition, when you right-click the identifier,
the context menu provides a Go to Cause item. Selecting this item takes you to the red
check that is the cause.

The software:

• Does not generate gray UNR checks if the cause is a red check
• Still generates red NTC, NTL, and K-NTC checks for a call or loop identifier if the

corresponding code contains orange checks.
• Does not generate NTC checks for the statements exit and abort, but provides

tooltips for these statements. For example, abort, which does not correspond to an
error, prevents the execution of a sequence of statements.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/br0l5ad-5.html#btel0eh-1
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Compatibility Considerations

As a result of this new feature, you might observe a significant reduction in the total
number of red and gray checks when compared to previous versions of the software.

Redefinition of Successful Verification

Previously, if a Polyspace verification failed, for example, during pass1
(Software Safety Analysis level 1), the software communicated the failure
through log messages and the Project Browser. However, if you clicked the
xx_LAST_RESULTS.exe file within the Project Browser, the software displayed any
results (colored checks) that had been generated by the verification. Now, the software
deems a verification successful provided some results have been generated.

Polyspace Report Generator Enhancements

You can:

• Generate multiple reports in the Results Manager perspective. See Generating
Verification Reports.

• Customize report templates with MATLAB Report Generator software, which allows
you to filter results by:

• Justification status — Display all, justified, or unjustified checks.
• Type — Display only listed types of run-time checks.
• Function — Display only run-time checks from specified functions.

For more information, see Customizing Verification Reports.

Polyspace In One Click (POC) Enhancement

The POC software has been rewritten. The software that replaces the previous Send To
functionality now runs verifications without requesting additional settings. See Using
Polyspace In One Click.

Note: Support for the Send To feature will be removed in a future release.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/br78ltt-1.html#br78ltt-3
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/br78ltt-1.html#br78ltt-3
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/br78ltt-1.html#bs6zag5
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/br2o6vq-3.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/br2o6vq-3.html
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Header Files Without Run-Time Checks

It is quite common for code to contain header files with library inline functions that are
never called. Previously, these files were listed in the Results Explorer view, which
could slow down your review of results. Now, if header files do not contain run-time
checks, the software does not list these header files in the Results Explorer view.

Improved Access to Polyspace Demos

In the Polyspace verification environment, you can now open supplied Demo projects
through the Help menu.

Changes to Verification Results

Compatibility Considerations

Verification results might change when compared to previous versions of the software.
Some checks might change color, and the Selectivity rate of your results might change.

NTC and NTL Checks

See “Suppression of NTC, NTL and UNR Checks Caused by Red Checks” on page
7-3.

Changes to Analysis Options

New Options

None

Changes to Existing Options

No name changes to existing options

Options Removed

None
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Enhanced Polyspace Metrics Project Index

The enhanced project index enables you to display projects as categories, which is useful
when you have a large number of projects to manage. Now, you can:

• Create multiple-level project categories.
• Move projects between categories by dragging and dropping projects.
• Rename and remove categories. You can remove categories without deleting the

projects within the categories. The software moves these projects back to the root
level.

For more information, see Organizing Polyspace Metrics Projects.

Redefinition of Successful Verification

Previously, if a Polyspace verification failed, for example, during pass1
(Software Safety Analysis level 1), the software communicated the failure
through log messages and the Project Browser. However, if you clicked the
xx_LAST_RESULTS.exe file within the Project Browser, the software displayed any
results (colored checks) that had been generated by the verification. Now, the software
deems a verification successful provided some results have been generated.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/bsoyuq_.html#btc91mq
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Review Orange Checks that are Potential Run-Time Errors

Previously, there were two modes in which you could review verification results —
manual and assistant. For the manual mode, you set the Assistant slider to Off and the
software displayed all orange checks (in addition to the red and green checks) . With the
assistant mode, there were three levels of review — corresponding to settings 1, 2, and 3
of the Assistant slider. You could specify the number of orange checks to display through
the Assistant Configuration tab in the Polyspace Preference dialog box.

Now, Polyspace allows you to review results at five different levels. You can set the
Review slider to 0, 1, 2, 3, or All:

• 0 — Display red and gray checks. In addition, display orange checks that are
potential run-time errors. On the Polyspace Preference > Review Configuration
tab, you can specify the type of potential run-time errors that you are interested in.
You have the option of not displaying any orange checks.

• 1, 2, and 3 — This functionality is unchanged. Display red, gray, and green checks.
In addition, display orange checks according to values specified on the Polyspace
Preference > Review Configuration tab.

• All — Display red, gray, green, and all orange checks.

The Assistant Configuration tab is renamed the Review Configuration tab.

No Gray Checks in Unreachable Code

The only gray checks that Polyspace generates now are UNR checks for unreachable
branches of code. In addition, Polyspace generates the UNR check only at the highest level
of a branch. You no longer see nested UNR checks , that is, UNR checks in sub-branches.

In addition, the software displays two new metrics for the project in the procedural
entities view:

• unp — Number of unreachable procedures (functions) as a fraction of the total
number of procedures (functions)

• cov — Percentage of elementary operations in executable procedures (functions)
covered by verification
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These metrics provide:

• A measure of the code coverage achieved by the Polyspace verification.
• Indicators about the validity of your Polyspace configuration. For example, a large

unp value and a low cov value may indicate an early red check or missing function
call.

See Results Explorer Tab.

Compatibility Considerations

Due to the removal of non-UNR gray checks and nested UNR checks, verification results
may change when compared to previous versions of the software.

Global Variable Range Information

In the Variable Access pane, Polyspace displays range information for read and write
access operations on global variables within each source file. Previously, the displayed
value was the union of all access operations on the global variable within a file. The
software did not display range information for individual operations. Now, for global
variables that are signed or unsigned integers, Polyspace also provides range information
for the individual access operations from which the union value is obtained.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/brz384r-1.html#brz384r-11
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See Variable Access Pane.

Read and Write Access in Dead Code

If a read or write access operation on a global variable lies within dead code, then
Polyspace colors the operation gray in the Variable Access pane. When you examine

verification results, you can hide these operations by clicking the new filter button .
See Variable Access Pane.

Run All Verifications in Project

You can have many verifications within a project, each verification being associated with
an active configuration. Previously, you could only run one verification at a time from
the Polyspace verification environment (PVE). Now, if you select a project and click the

button , Polyspace will run all verifications in the project. See Running a
Verification.

Green NIV check for Unchecked_Conversion Function

Previously, the software produced an orange NIV check for each call to an
instance of the Ada generic library function Unchecked_Conversion. Now
by default, the software produces a green NIV check for each call. If you want
to revert to the previous behavior, run your verification with the option -D
POLYSPACE_UNCHECKED_CONVERSION_NO_INIT.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/brz384r-1.html#bsg3vmw-6
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/brz384r-1.html#bsg3vmw-6
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/br0l3n3-1.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/br0l3n3-1.html
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Running Multiple Verifications Simultaneously

If you purchase more than one license for a Polyspace server, you can now configure the
server to run multiple verifications at the same time. This can improve the performance
of server verifications.

To configure your server to run multiple verifications, open the Remote Launcher
Manager, then set the Number of Polyspace verifications that can run
simultaneously on this server to the number of licenses you have activated for your
server.

For more information, see Configuring Polyspace Server Software in the Polyspace
Installation Guide.

Compatibility Considerations

If you configure your server to run more than one verification simultaneously, the server
will not be able to run verifications using older versions of the software.

For example, if your server has both R2011a and R2011b software installed, you cannot
run a verification using the R2011a software.

Polyspace Metrics

Review Changes between Results of Successive Verifications

You can specify a version of a project and review only the differences between verification
results of the specified version and the previous verification. See Review New Findings.

File Modules with Quality Levels

If you have projects with two or more file modules in the Polyspace verification
environment, by default Polyspace Metrics displays verification results using the same
module structure. However, Polyspace Metrics also allows you to create or delete file
modules. You can group files into a module and specify a quality level for the module,
which applies to all files within the module. This feature allows you to specify different
quality levels for your files in the review of verification results. See Creating a File
Module and Specifying Quality Level.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brl87c1.html#brl87ch-1
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/bsoyuoo.html#bs6vu7m
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/bsoyuoo.html#bs6vq4s
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/bsoyuoo.html#bs6vq4s
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Enhanced Graphs and Charts

Polyspace Metrics displays enhanced graphs and charts.

If you specify a range of project versions:

• On the Summary tab, Run-Time Defects are plotted as separate categories, High,
Medium, and Low.

• On the Run-Time Checks tab:

• Under Confirmed Defects, you see separate plots for the defect categories, High,
Medium, and Low.

• Under Run-Time Findings, you see separate plots for red checks, NTC checks,
and gray checks.

If you specify a single version of a project, Polyspace Metrics displays file defect
information, ordering the files according to the number of defects in each file. Use the
new # items field to specify the maximum number of files for which information is
displayed. See Displaying Metrics for Single Project Version.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/bsoyuoo.html#bs6vq3z
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Code Metrics

Polyspace Metrics now generates Ada code metrics, giving you the number of:

• Protected shared variables
• Unprotected shared variables
• Files
• Lines of code
• Packages
• Packages that appear in with statements
• Subprograms that appear in with statements

You can view the metrics by:

• Using a Web browser to access the Code Metrics view of your project in Polyspace
Metrics

• Examining the XML file that the software generates

For more information, see Setting Up Verification to Generate Metrics and Review Code
Metrics in the Polyspace Products for Ada User's Guide.

Saving Polyspace Metrics Review

Previously, when you saved your project (Ctrl+S) after a review of results from Polyspace
Metrics, the software would save your comments and justifications both locally and in the
Polyspace Metrics repository.

Now, if you save your project (Ctrl+S), the software saves your review to a local folder

only. A new button  is available on the Run-Time Checks toolbar. If you click this
button, the software saves your comments and justifications to a local folder and the
Polyspace Metrics repository.

This feature allows you to upload your review to the repository only when you are
satisfied that your review is, for example, correct and complete.

You can still configure your software to display the previous behavior.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/bsoyun8.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/bsoyuoo.html#bswoylk
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/bsoyuoo.html#bswoylk
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
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For more information, see Saving Review Comments and Justifications in the Polyspace
Products for Ada User's Guide.

Support for Rational and Aonix Compilers

The software now provides support for the IBM Rational Apex and Aonix® compilers. For
more information, see Operating system target for Standard Libraries compatibility in
the Polyspace Products for Ada Reference.

Multi-Core Support

On multi-core computers, you can reduce verification time by specifying the use of
core processors simultaneously to perform the verification. The software provides a
new command line option –max-processes, which uses a default value of 4. You can
specify any value between 1 and 128. For more information, see Number of processes for
multiple CPU core systems in the Polyspace Products for Ada Reference.

Generated Main with Explicit Tasks and Accept Statements

If you select the option Generate a main and there are explicit tasks in the source
code, then task bodies are verified like subprograms and accept statements are not
executed. After verification, code associated with the accept statements is gray. For
more information, see Generate a main in the Polyspace Products for Ada Reference.

Compatibility Considerations

Previously, if there were explicit tasks and accept statements in the source code, a
verification run could have generated red, green, or orange checks for code within the
accept statements. Now, verification colors the code within these accept statements
gray.

Enhancements in Run-Time Checks Perspective

Within the source code view, you can investigate checks with tooltips that provide range
information about variables.

In addition, when you click a check, the software provides information about the check in
the Review Details pane.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/bsoyuoo.html#bszt55z
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ref/brid6c2.html#br86f6j-1
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ref/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ref/brid6dc.html#bsvy53t
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ref/brid6dc.html#bsvy53t
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ref/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ref/brid6dc.html#br86m3g-1
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ref/ug_intropage.html
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For more information, see Using Range Information in Results Manager Perspective and
Selecting a Check to Review in the Polyspace Products for Ada User's Guide.

Compatibility Considerations

Because of these enhancements, the IPT and VOA checks are no longer required, and the
software does not generate these checks anymore.

UOVFL and UNFL Checks Removed

The software no longer generates UOVFL and UNFL checks, but generates OVFL checks
in place of these checks.

Compatibility Considerations

Due to the replacement of UOVFL and UNFL checks by the OVFL check, the number of
green checks may decrease when compared with previous versions of the software. For
example, a combination of an orange OVFL and a green UNFL generated by a previous
version may be replaced by a single orange OVFL.

NIV Checks for Universal Constants

The software now generates NIV checks for read operations on universal constants. If
the constants are used in your code, the NIV checks are green. If the constants are in
unreacheable code, the NIV checks are gray.

Compatibility Considerations

This enhancement may change the check metrics and selectivity of the verification. The
number of green and gray checks may be higher compared to the number generated by
previous versions of the software.

Variable Range Inconsistency between Variable Access Pane and Tooltips

The range given for a variable in the Variable Access Pane (Variables View) can differ
from the range given by tooltips on the reads of a variable in the Source code view. The
range provided by the tooltip will be wider than the range given in the Variables View.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/brzsavx-1.html#bsvylfx
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/brz384r-12.html#brz384r-16
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
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This difference is due to imprecision in the tooltip. The Variables View provides the
correct range for the variable.

For example:

• Variables View states that variable X is in range [0..4000]
• Tooltip on a read of X states that the range is [0,7000].

In this case, [0..4000] is the correct range. The tooltip range is caused by imprecision
that may be fixed in future releases.

Verification Time Limit

You can now specify a time limit for verifications using the -timeout option. If the
verification does not complete within the specified time, the verification fails.

For more information, see “Verification Time Limit” in the Polyspace Products for Ada
Reference.

Automatic Addition of Specifications for Selected Source Files

When launching a verification from the Eclipse IDE or the Polyspace Verification
Environment, the software automatically searches for the package specifications
associated with the selected source files, and adds them to the set of sources to verify.

As a result, the verification may contain more source files than you select.

Stubbed Tasks

Programs with stubbed tasks, such as those using Ada rendezvous, previously caused
compilation errors. These programs can now be verified.

Scaling Issue for Large Applications with Nested Structures/Arrays

With R2011a, you may experience scaling problems for large applications that
manipulate strongly nested structures or arrays. When verifying such applications, the
verification may fail during the “Software Safety Analysis Level 0” phase. No verification
results are generated, although the data dictionaries (Variable View and Call-Graph
View) are accessible.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ref/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ref/ug_intropage.html
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With previous releases, such applications could be verified, but the verification required
several days to complete, and produced results with very low selectivity.

If you experience this problem, try performing a unit-by-unit verification. For more
information, see Running Verification Unit-by-Unit in the Polyspace Products for Ada
User's Guide.

Compatibility Considerations

Verification may fail for code that was previously verified with an earlier version of the
product.

Product Name Change in Files and Folders

The Polyspace product name has changed from “PolySpace” to “Polyspace” in R2011a.
This change impacts the name of all files and folders created by the software.

For example:

• PolySpace-Doc folder has changed to Polyspace-Doc
• PolySpace_xxxx.log file has changed to Polyspace_xxxx.log

Compatibility Considerations

If you have existing folders that use the previous product name (for example,
PolySpace/PolySpace_Common) the R2011a installation will continue to use these
existing folders. However, files or folders created during or after installation will use the
new name.

If you have shortcuts or scripts that are case-sensitive, you should update them to use
the new name.

License Manager Support

The License Manager for Polyspace products has been upgraded to FlexNet® 11.9.

You may need to upgrade your FlexNet server and daemon.

For more information, see Polyspace License Installation in the Polyspace Installation
Guide.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/br0l3p7-6.html#br_rk17-1
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/br2e2qj.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html
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Changes to Verification Results

• “Write Access in Data Table with Main Generator and Protected Objects” on page
9-7

• “NIV for Variables Initialized at Declaration” on page 9-7
• “Range Error with greenhills OS Target” on page 9-8
• “UOVFL and UNFL Checks Removed” on page 9-8
• “NIV Checks for Universal Constants” on page 9-8
• “Constants Defined in Package System” on page 9-8
• “Initialization of Variables Declared and Assigned in Specs” on page 9-8
• “Parameterless Protected Procedure as Entry Point” on page 9-9

Compatibility Considerations

Verification results may change when compared to previous versions of the software.
Some checks may change color, and the Selectivity rate of your results may change.

Refer to the following sections for information on the specific changes.

Write Access in Data Table with Main Generator and Protected Objects

In previous releases, when using the -main-generator option, an incorrect write access
could appear in the data-table when entries of protected objects were called.

In R2011a, the data-table no longer includes locations with critical section names.

There may be less write accesses with protected objects that have defined entries when
you use the option -main-generator.

NIV for Variables Initialized at Declaration

In previous releases, there is no NIV check when a variable is initialized at the
declaration.

In R2011a, verification always puts NIV checks on variables and constants. OVFL checks
are not put on constants.

The total number of checks may change when compared with previous releases.
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Range Error with greenhills OS Target

In previous releases, verification could report a false red when using
“Ada.interrupts.Interrupt_ID” in source code designed for the greenhills compiler.

In R2011a, when you use the type Ada.interrupts.Interrupt_ID, and set the -OS-
target to greenhills, the bounds of the type Interrupt_ID have changed.

Verification results may change when compared to previous versions of the software.
Some checks may change color, and the Selectivity rate of your results may change.

UOVFL and UNFL Checks Removed

The software no longer generates UOVFL and UNFL checks, but generates OVFL checks
in place of these checks.

The number of checks may decrease compared to previous versions of the software.

NIV Checks for Universal Constants

The software now generates NIV checks for read operations on universal constants. If
the constants are used in your code, the NIV checks are green. If the constants are in
unreacheable code, the NIV checks are gray.

Verification results may change when compared to previous versions of the software. The
number of green and gray checks may be higher compared to the number generated by
previous versions of the software.

Constants Defined in Package System

In previous releases, constants defined in package system were ignored.

For example:

Max_Binary_Modulus    : constant := 16#100000000#; 

Max_Nonbinary_Modulus : constant := 16#FFFFFFFF#; 

In R2011a, values of constants defined in the package system that are used in the
program to be verified are taken into account for the verification. This may impact the
results.

Initialization of Variables Declared and Assigned in Specs

In previous releases, verification could incorrectly report a red ZDV check for a variable
of a type with default values, when the variable is global.
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In R2011a, when using the option -main-generator, components with initial values of
global variables of composite types that are not initialized are considered full range.

Verification results may change when compared to previous versions of the software.
Some checks may change color, and the Selectivity rate of your results may change.

Parameterless Protected Procedure as Entry Point

In previous releases, when a parameterless protected procedure is used as an entry point
via the option -entry-points, the verification fails.

In R2011a, parameterless protected procedures applied to a global object are now
accepted as values of the option -entry-points.

Changes to Analysis Options

New Options

• Calculate code metrics (-code metrics) – See “Code Metrics” on page 9-2.
• Verification time limit (-timeout) – See “Verification Time Limit” on page

9-5.
• Number of processes for multiple CPU core systems (-max-processes) – See

“Multi-Core Support” on page 9-3.
• Less range information (-less-range-information) – See “Enhancements in

Run-Time Checks Perspective” on page 9-3.

Changes to Existing Options

None

Deprecated Options

None
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Code Metrics

Polyspace Metrics now generates Ada code metrics, giving you the number of:

• Protected shared variables
• Unprotected shared variables
• Files
• Lines of code
• Packages
• Packages that appear in with statements
• Subprograms that appear in with statements

You can view the metrics by:

• Using a Web browser to access the Code Metrics view of your project in Polyspace
Metrics

• Examining the XML file that the software generates

For more information, see Setting Up Verification to Generate Metrics and Review Code
Metrics in the Polyspace Products for Ada User's Guide.

Saving Polyspace Metrics Review

Previously, when you saved your project (Ctrl+S) after a review of results from Polyspace
Metrics, the software would save your comments and justifications both locally and in the
Polyspace Metrics repository.

Now, if you save your project (Ctrl+S), the software saves your review to a local folder

only. A new button  is available on the Run-Time Checks toolbar. If you click this
button, the software saves your comments and justifications to a local folder and the
Polyspace Metrics repository.

This feature allows you to upload your review to the repository only when you are
satisfied that your review is, for example, correct and complete.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/bsoyun8.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/bsoyuoo.html#bswoylk
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/bsoyuoo.html#bswoylk
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
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You can still configure your software to display the previous behavior.

For more information, see Saving Review Comments and Justifications in the Polyspace
Products for Ada User's Guide.

Multi-Core Support

On multi-core computers, you can reduce verification time by specifying the use of core
processors simultaneously to perform the verification. The software provides a new
command line option –max-processes, which uses a default value of 4. You can specify
any value between 1 and 128.

For more information, see Number of processes for multiple CPU core systems in the
Polyspace Products for Ada Reference.

Generated Main with Explicit Tasks and Accept Statements

If you select the option Generate a main and there are explicit tasks in the source
code, then task bodies are verified like subprograms and accept statements are not
executed. After verification, code associated with the accept statements is gray. For
more information, see Generate a main in the Polyspace Products for Ada Reference.

Compatibility Considerations

Previously, if there were explicit tasks and accept statements in the source code, a
verification run could have generated red, green, or orange checks for code within the
accept statements. Now, verification colors the code within these accept statements
gray.

Automatic Comment Import for Server Verifications

When you download results from the Polyspace server, the software now automatically
imports any comments from results in the destination folder into the downloaded results
(except for verifications using the option -add-to-results-repository).

As a result of this change, you can now download intermediate results for a verification
running on the Polyspace server, and add or edit comments on those results. When you
later download the final results, your comments are preserved.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/bsoyuoo.html#bszt55z
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ref/brid6dc.html#bsvy53t
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ref/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ref/brid6dc.html#br86m3g-1
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ref/ug_intropage.html
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You can also download and comment on a single unit of a unit-by-unit verification, even
if other units are still pending in the server queue. When you download the final results
(which overwrites the earlier results), your comments are preserved.

License Manager Support

The License Manager for Polyspace products has been upgraded to FlexNet 11.9.

You may need to upgrade your FlexNet server and daemon.

For more information, see Polyspace License Installation in the Polyspace Installation
Guide.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/br2e2qj.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html


R2010b
Version: 6.0

New Features

Bug Fixes

Compatibility Considerations
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Polyspace Graphical User Interface

Redesigned Polyspace graphical user interface replaces the Launcher and Viewer
modules with a single, unified interface called the Polyspace verification environment
(PVE).

You use the Polyspace verification environment to create Polyspace projects, launch
verifications, and review verification results. The new interface also enables you to
provide comments in the source code or in the results.

The Polyspace verification environment consists of two perspectives:

• “Project Manager Perspective” on page 10-2
• “Run-Time Checks Perspective” on page 10-3

Project Manager Perspective

The Project Manager perspective allows you to create projects, set verification
parameters, and launch verifications.
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For information on using the Project Manager perspective, see Setting Up a Verification
Project in the Polyspace Products for Ada User's Guide.

Run-Time Checks Perspective

The Run-Time Checks perspective allows you to review verification results, comment
individual checks, and track review progress.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/brimow9-1.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/brimow9-1.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html


R2010b

10-4

For information on using the Run-Time Checks perspective, see Reviewing Verification
Results in the Polyspace Products for Ada User's Guide.

Data Range Specifications

The Data Range Specifications (DRS) feature allows you to set constraints on data ranges
using a text file. With this text file, you can specify data ranges for global variables,
stubbed functions and procedures, and function call inputs.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/brj0wna.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/brj0wna.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
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For more information, see Specifying Data Ranges for Variables, Functions, and
Procedures in the Polyspace Products for Ada User's Guide.

Extended Support for Tasks

You can now verify Ada code that contains the following task-related features :

• Pointers to explicit tasks
• Private task types
• Tasks with discriminants
• Entry families
• Explicit tasks declared in a package – you can now verify the package with the -

main-generator option

Previously, these features would generate errors during a verification.

Preprocessor Macros for Compilation

You can now specify, with the -D option, the use of preprocessor macros in code
compilation. The -U option, which nullifies this -D option, is also available.

For more information, see Defined Preprocessor Macros(-D compiler-flag) and Undefined
Preprocessor Macros (-U compiler-flag) in the Polyspace Products for Ada Reference
Guide.

New Options to Classify Run-Time Checks

When reviewing results in the Run-Time Checks perspective, the software now provides
additional options for classifying checks

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/bsofti6.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/bsofti6.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ref/brid6c2.html#bspw5yk-1
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ref/brid6c2.html#bspw5yk-1
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ref/brid6c2.html#bspxbl1-1
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ref/brid6c2.html#bspxbl1-1
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ref/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ref/ug_intropage.html
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After you review the check, you can specify the following:

• Classification – Select an option to describe the seriousness of the issue.
• Status – Select an option to describe how you intend to address the issue.
• Justified – Select the check box to indicate that you have justified this check.
• Comment – Enter additional information about the check

The software provides pre-defined values for Classification and Status. You can also
define your own statuses.

In addition to reviewing checks through the user interface, you can place comments in
your code that highlight and categorize checks identified in previous verifications. The
software displays the information that you provide within your code comments, and
marks the checks as Justified.

For more information, see Reviewing and Commenting Checks in the Polyspace Products
for Ada User's Guide.

Compatibility Considerations

The syntax for code comments has changed to reflect the new options for categorizing
checks.

The syntax for run-time checks is now:

-- polyspace<RTE:RTE1 : [Classification] : [Status] > [Comment]

If you placed comments in your code using the previous syntax, the comments will still
appear in your results, but the text may be displayed in different columns.

For more information, see Syntax for Run-Time Errors in the Polyspace Products for Ada
User's Guide.

Permissiveness on File and Folder Names

Polyspace software now allows space characters in the names of Projects, source files,
and folders, as well as in option arguments.

In addition, multiple source files with the same name are now allowed.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/bsg3vp7-1.html#bsg3vp7-3
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/bsfqozl.html#bsfqo82
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
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Note: Non-ASCII characters in file names are not supported.

Default Target Processor

The default setting of the Target processor type (-target-processor) option has
changed from SPARC to i386.

Compatibility Considerations

If you launch verifications without specifying a value for this option, the default value
has changed. Therefore, your verification results may change when compared to previous
versions of the software. Some checks may change color, and the Selectivity rate of your
results may change.

Operating System Support

Added support for the Windows 7 operating system.

Solaris™ operating system is no longer supported for new installations.

For more information, see the Polyspace Installation Guide.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html
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Polyspace Metrics Web Interface

A web-based tool for software development managers, quality assurance engineers, and
software developers, which allows you to do the following in software projects:

• Evaluate software quality metrics
• Monitor the variation of code metrics, and run-time checks through the lifecycle of a

project
• View defect numbers, run-time reliability of the software, review progress, and the

status of the code with respect to software quality objectives.

In addition, if you have the Polyspace Client™ for Ada product installed on your
computer, you can drill down to run-time checks in the Polyspace verification
environment. You can review these run-time checks and, if required, classify these
checks as defects.

For more information, see Software Quality with Polyspace Metrics in the Polyspace
Products for Ada User's Guide.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/bsoyuhx.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html


 Polyspace Server for Ada Product

10-9

Automatic Verification

Configure verifications to start automatically and periodically, for example, at a specific
time every night. At the end of each verification, the software stores results in a results
repository and updates the metrics for your software project. You can also configure the
software to send you an email at the end of the verification. This email contains links to
results, compilation errors, run-time errors, or processing errors.

For more information, see Specifying Automatic Verification in the Polyspace Products
for Ada User's Guide.

Operating System Support

Added support for the Windows 7 operating system.

Solaris operating system is no longer supported for new installations.

For more information, see the Polyspace Installation Guide.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/bsoyun8.html#bsoyuxd
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html
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License Activation

Polyspace products now support the MathWorks software activation mechanism.

Activation is a process that verifies licensed use of MathWorks® products. The process
validates your product licenses and ensures that they are used correctly. You must
complete the activation process before you can use Polyspace software.

Note: If you are using Designated Computer (Individual) licenses, you must activate the
license for each Polyspace system individually. However, if you are using Concurrent
licenses for multiple Polyspace systems, you do not need to activate each Polyspace
system. You activate the license once (for the FLEXnet license server), then provide
license files for each Polyspace system.

The easiest way to activate the software is to log in to your MathWorks Account during
installation. At the end of the installation process, the Polyspace Software Activation
dialog box opens.
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Follow the prompts in the Polyspace Software Activation dialog box to complete the
activation process.

If you do not have a MathWorks account, you can create one during the activation
process. To create an account, you must have an Activation Key, which identifies the
license you want to install and activate.

If your Polyspace system is not connected to the internet, you can access the MathWorks
License Center on a computer with internet access, activate your license, and download a
license file for transfer to your Polyspace system. If you do not have access to a computer
with an Internet connection, contact Customer Support.

For more information on how to activate your software, see Activating Polyspace
Softwarein the Polyspace Installation Guide.

For more information on software activation, including frequently asked questions, refer
to the MathWorks Web site: www.mathworks.com/support/activation/polyspace.html

Source Code Comment Support

Polyspace software now allows you to place comments in your code that provide
information about known run-time errors. You can use these comments to highlight and
categorize previously identified run-time errors. This information can then make the
review process quicker and easier.

When you review verification results, the Viewer displays comments on individual
checks. You can then skip these commented checks during the review process, or simply
use them as additional information during your review.

For more information, see Highlighting Known Run-Time Errors in the Polyspace
Products for Ada User's Guide.

Eclipse Integration

Polyspace integration with the Eclipse IDE, Version 3.4 and 3.5.

The Polyspace Client for Ada can be integrated with the Eclipse™ Integrated
Development Environment through the Polyspace plug-in for Eclipse IDE.

This plug-in provides Polyspace source code verification and bug detection functionality
for source code developed within Eclipse IDE. Features include the following:

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brhnuz0.html#bse5qz6-1
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brhnuz0.html#bse5qz6-1
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html
http://www.mathworks.com/support/activation/polyspace.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/bsfqozl.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
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• A contextual menu that allows you to launch a verification of one or more files.
• Views in the Eclipse editor that allow you to set verification parameters and monitor

verification progress.

For more information, see Using Polyspace Software in the Eclipse IDE in the Polyspace
Products for Ada User's Guide.

Operating System Support

Added support for the following Linux distributions:

• OpenSuSE 11.1
• Debian 5.x
• Ubuntu 8.04, 8.10, 9.04, and 9.10

For more information, see the Polyspace Installation Guide.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/c_ug/br0k7_3-1.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html
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License Activation

Polyspace products now support the MathWorks software activation mechanism.

Activation is a process that verifies licensed use of MathWorks products. The process
validates your product licenses and ensures that they are used correctly. You must
complete the activation process before you can use Polyspace software.

Note: If you are using Designated Computer (Individual) licenses, you must activate the
license for each Polyspace system individually. However, if you are using Concurrent
licenses for multiple Polyspace systems, you do not need to activate each Polyspace
system. You activate the license once (for the FLEXnet license server), then provide
license files for each Polyspace system.

The easiest way to activate the software is to log in to your MathWorks Account during
installation. At the end of the installation process, the Polyspace Software Activation
dialog box opens.
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Follow the prompts in the Polyspace Software Activation dialog box to complete the
activation process.

If you do not have a MathWorks account, you can create one during the activation
process. To create an account, you must have an Activation Key, which identifies the
license you want to install and activate.

If your Polyspace system is not connected to the internet, you can access the MathWorks
License Center on a computer with internet access, activate your license, and download a
license file for transfer to your Polyspace system. If you do not have access to a computer
with an Internet connection, contact Customer Support.

For more information on how to activate your software, see Activating Polyspace
Softwarein the Polyspace Installation Guide.

For more information on software activation, including frequently asked questions, refer
to the MathWorks Web site: www.mathworks.com/support/activation/polyspace.html

Queue Manager Interface

The Polyspace Queue Manager Interface (Spooler) is now available on Linux machines,
providing a graphical interface for managing verification jobs on the Polyspace server.

For more information, see Managing Verification Jobs Using Polyspace Queue
Managerin the Polyspace Products for Ada User's Guide.

Operating System Support

Added support for the following Linux distributions:

• OpenSuSE 11.1

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brhnuz0.html#bse5qz6-1
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brhnuz0.html#bse5qz6-1
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html
http://www.mathworks.com/support/activation/polyspace.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/br0l3p7-6.html#br0l3p7-8
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/br0l3p7-6.html#br0l3p7-8
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
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• Debian 5.x
• Ubuntu 8.04, 8.10, 9.04, and 9.10

For more information, see the Polyspace Installation Guide.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html
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Report Generator

New Report Generator that presents Polyspace results in PDF, HTML, and other output
formats.

The Polyspace Report Generator allows you to generate reports about your verification
results, using the following predefined report templates:

• Coding Rules Report – Provides information about compliance with MISRA-C
Coding Rules, as well as Polyspace configuration settings for the verification.

• Developer Report – Provides information useful to developers, including summary
results, detailed lists of red, orange, and gray checks, and Polyspace configuration
settings for the verification.

• Developer with Green Checks Report – Provides the same content as the
Developer Report, but also includes a detailed list of green checks.

• Quality Report – Provides information useful to quality engineers, including
summary results, statistics about the code, graphs showing distributions of checks per
file, and Polyspace configuration settings for the verification.

The Polyspace Report Generator allows you to generate verification reports in the
following formats:

• HTML
• PDF
• RTF
• Microsoft® Word
• XML

Note: Microsoft Word format is not available on UNIX platforms. RTF format is used
instead.

For more information, see Generating Reports of Verification Results in the Polyspace
Products for Ada User's Guide .

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/br78ltt-1.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
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Main Generator Enhancements

Enhanced main generator that considers the scope of a procedure and variable,
improving error detection at the package level.

This change may affect your results compared with previous releases, and how you
interpret the new results. Specific changes include:

• Uninitialized package body variables are considered uninitialized
• Uncalled package-scope procedures/functions are considered unreachable
• Functions/procedures declared at the spec level are called only once
• Uninitialized spec level variables are considered possibly uninitialized

For more information on the main generator, see Main Generator Overview in the
Polyspace Products for Ada User's Guide .

Uninitialized Package Body Variables are Considered Uninitialized

Uninitialized variables that are declared only in the package body are now considered
uninitialized, and generate red NIV checks.

Previously, these variables were considered initialized (green NIV) with full-range
values. This behavior made interpretation of results easier and allowed verification to
continue. However, the software now considers these variables uninitialized (red NIV)
and stops verification at this point. This new behavior is more accurate with respect
to the actual initialization state of the variables. You must correct the code before
verification can continue. Alternatively, you can use the option -continue-with-all-
niv.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/br1kxv1.html#br1kxwn-1
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
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Uncalled Package-scope Procedures/Functions are Considered Unreachable

Procedures and functions that are declared in the package but not called by code within
the package body provided for the verification will now be considered unreachable (gray).

Previously, all procedures and functions in a package were considered for verification
and subsequently colored. The argument for this behavior was that these functions and
procedures could be called by code inside the package that had not been provided for the
verification. Now, the software considers this code unreachable (gray) unless there is a
path of execution that leads to it.
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Functions/Procedures Declared at the Spec Level are Called Only Once

Functions or procedures declared at the specification level are called only once.

Note: This behavior changed in Release 2010a. In R2010a or later, the main generator
can call a function several times.

Uninitialized Spec Level Variables are Considered Possibly Uninitialized

Uninitialized variables declared in a package specification will now be considered
possibly uninitialized (orange NIV). Previously, these variables were considered
initialized (green NIV) with full-range values.

The software now considers uninitialized variables that are declared only in the package
body as uninitialized (red NIV). However, for uninitialized variables declared in a
package specification, it is possible that packages that use these variables may initialize
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these variables. The software now recognizes this possibility and generates orange NIV
checks for uninitialized variables declared in a package specification.

This behavior is not changed if you use options -init-stubbing-vars-random
or -init-stubbing-vars-zero-or-random to initialize uninitialized variables.
Specification-level variables will still be considered possibly uninitialized (orange NIV),
because the packages that use these variables can alter the variables, even to the extent
of uninitializing the variables.

Compatibility Considerations

Changes to the main generator may result in differences in your verification results,
when compared with earlier versions of the software. If you verified your code with
previous versions of the software (for example, R2009a), be aware of these changes, how
they affect your colored results and the way you interpret the results.
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Global Data Graphs

New Graphs (similar to concurrent access graphs) available for all global data.

You can display the access sequence for any variable that is read or written in the code.
The access graph displays the read and write access for the variable.

For more information, see Displaying the Access Graph for Variables in the Polyspace
Products for Ada User's Guide .

Unit-by-unit Verification

New option to create a separate verification job for each source file in the project.

When you run a unit-by-unit verification, each source file is compiled, sent to the
Polyspace Server, and verified individually.

The queue manager displays a job for the full verification group, as well as jobs for each
unit (using a tree structure).

When verification is complete, you can download and view results for the entire project,
or for individual units. When downloading a verification group, all the unit results are
downloaded and a summary of the download status for each unit is displayed.

Note: Unit by unit verification is available only for server verifications.

For more information, see Running Verification Unit-by-Unit in the Polyspace Products
for Ada Reference.

Operating System Support

Added support for Windows Server 2008.

For more information, see the Polyspace Installation Guide.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/brz384r-12.html#br78lwn-1
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/br0l3p7-6.html#br_rk17-1
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ref/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ref/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html
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Polyspace Server for Ada Product

Operating System Support

Added support for Windows Server 2008.

For more information, see the Polyspace Installation Guide.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html
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Version: 5.3

New Features

Bug Fixes
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Polyspace Client for Ada Product

Character Encoding Options

New character encoding option allows you to view source files created on an operating
system that uses different character encoding than your current system.

You specify the character encoding used by the operating system on which the source
file was created using the Character encoding tab in the Preferences dialog box of the
Polyspace Viewer.

For more information, see Setting Character Encoding Preferences in the Polyspace
Products for Ada User's Guide.

Operating System Support

Added support for Windows Server 2003, Windows Vista™, and Red Hat Enterprise
Linux Workstation v.5.

For more information, see the Polyspace Installation Guide.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/c_ug/brz384r-1.html#br2eii_
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/ada_ug/ug_intropage.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html
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Polyspace Server for Ada Product

Operating System Support

Added support for Windows Server 2003, Windows Vista, and Red Hat Enterprise Linux
Workstation v.5.

For more information, see the Polyspace Installation Guide.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html
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Version: 5.2

New Features

Bug Fixes
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Polyspace Client for Ada Product

Operating System Support

Added support for 64–bit Linux.

For more information, see the Polyspace Installation Guide.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html
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Polyspace Server for Ada Product

Operating System Support

Added support for 64–bit Linux.

For more information, see the Polyspace Installation Guide.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html




R2008a
Version: 5.1

New Features

Bug Fixes

Compatibility Considerations
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Polyspace Client for Ada Product

Removed Cygwin Software Dependency for Windows Platforms

Previous versions of Polyspace products used Cygwin™ emulation to run UNIX®

commands on Windows systems.

In version 5.1, the Cygwin software dependency has been removed. Removing Cygwin
simplifies the Polyspace product installation process while improving the performance
and robustness of the Polyspace Verification process.

Compatibility Considerations

Due to the Cygwin changes, Polyspace Client for Ada Version 5.1 is not compatible with
previous versions of Polyspace products on Windows platforms. To avoid compatibility
problems on Windows platforms, you must upgrade all your Polyspace client and server
products at the same time.

If your Polyspace server is running on a Windows platform, the binary files used for
batch commands in previous releases will not work without Cygwin software installed.
In version 5.1, the software provides new .exe files for these batch commands. However,
these files are now located in a different location.

Commands Previous Location New Location

Standard PolyspaceInstallDir\verifier

\bin\

PolyspaceInstallDir\verifier

\wbin\

Remote
Launcher

Polyspace_Common\RemoteLauncher

\bin\

Polyspace_Common\RemoteLauncher

\wbin\

Viewer Polyspace_Common\Viewer\bin\ Polyspace_Common\Viewer

\wbin\

If you wrote scripts using batch commands in previous releases, you must modify the
scripts to use the new commands.

In addition, if you used Cygwin shell scripts for postprocessing or target compilation,
those scripts will no longer run on version 5.1. To support scripting, the Polyspace
software now includes Perl. You can access Perl in:
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PolyspaceInstallDir\verifier\tools\perl\win32\bin\perl.exe

Enhanced Installer

Version 5.1 includes an enhanced and simplified installer for all Polyspace products. The
installation process is now faster and easier to complete than in previous releases.

For more information, see the Polyspace Installation Guide.

Viewer Improvements

Enhanced exploring capability in the viewer to provide more focused information.

Unnecessary information has been eliminated from the Procedural Entities (RTE) View
and Call Tree View to improve usability.

Enhanced Compilation Checks

Enhanced compilation checks to stop verification only when a pointer to a task is
initiated or used, rather than when it is declared.

One-Click Enhancements

Enhanced Polyspace-In-One-Click options, to allow switching between multiple projects
using a browse history.

Operating System Support

Added support for the following operating systems:

• Solaris 2.10
• Windows XP x64 (32-bit mode)

For more information, see the Polyspace Installation Guide.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html
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Polyspace Server for Ada Product

Removed Cygwin Software Dependency for Windows Platforms

Previous versions of Polyspace products used Cygwin emulation to run UNIX commands
on Windows systems.

In version 5.1, the Cygwin software dependency has been removed. Removing Cygwin
simplifies the Polyspace product installation process while improving the performance
and robustness of the Polyspace Verification process.

Compatibility Considerations

Due to the Cygwin changes, Polyspace Server for Ada Version 5.1 is not compatible with
previous versions of Polyspace products on Windows platforms. To avoid compatibility
problems on Windows platforms, you must upgrade all your Polyspace client and server
products at the same time.

If your Polyspace server is running on a Windows platform, the binary files used for
batch commands in previous releases will not work without Cygwin software installed.
In version 5.1, the software provides new .exe files for these batch commands. However,
these files are now located in a different location.

Commands Previous Location New Location

Standard PolyspaceInstallDir\verifier

\bin\

PolyspaceInstallDir\verifier

\wbin\

Remote Launcher Polyspace_Common\RemoteLauncher

\bin\

Polyspace_Common\RemoteLauncher

\wbin\

Viewer Polyspace_Common\Viewer

\bin\

Polyspace_Common\Viewer

\wbin\

If you wrote scripts using batch commands in previous releases, you must modify the
scripts to use the new commands.

In addition, if you used Cygwin shell scripts for postprocessing or target compilation,
those scripts will no longer run on version 5.1. To support scripting, the Polyspace
software now includes Perl. You can access Perl in:

PolyspaceInstallDir\verifier\tools\perl\win32\bin\perl.exe
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Enhanced Installer

Version 5.1 includes an enhanced and simplified installer for all Polyspace products. The
installation process is now faster and easier to complete than in previous releases.

For more information, see the Polyspace Installation Guide.

Operating System Support

Added support for the following operating systems:

• Solaris 2.10
• Windows XP x64 (32-bit mode)

For more information, see the Polyspace Installation Guide.

http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html
http://www.mathworks.com/help/releases/R2012a/toolbox/polyspace/polyspace_install/brvjckt-1.html



